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PLEASE NOTE: This content is only relevant for NMCI 0365 users
that have had their email migrated into Flank Speed. If you are
unsure if you have been migrated or not, see Step 1 on page 1.

o
‘ Stay connected on Teams @j
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Getting Started in Outlook

Congrats! You have a new @us.navy.mil email address and your old @navy.mil account has successfully
been migrated to Flank Speed. This means you will no longer have access to your @navy.mil inbox, but all
of your emails, calendar invites, contacts, and tasks have been moved to your Flank Speed inbox for you.
In addition, forwarding has been set up to direct any new emails or invites sent to your old address to
your Flank Speed inbox. Any outgoing messages will be sent from your new @us.navy.mil account.

In order to ensure your mailbox has been moved and get your Outlook client set up for Flank Speed,
please follow these steps:

Confirm your @navy.mil inbox moved to your Flank Speed account.

Log in to your Flank Speed account (@us.navy.mil) via https://portal.apps.mil (the Edge browser

with an "InPrivate" window is preferred). If you have not logged in before, please reference the Startup

Guide posted here. If you are unable to access Outlook from the portal, try accessing directly via
https://outlook-dod.office365.us/.

If your email appears at login—congrats, you're migrated! G

You can now use Outlook via your web browser. 500

If you get the 500 error at right, your email has not been ?methmg WERE WS

migrated yet. If you can't access Flank Speed Outlook 5 ) g AT S——
Web Access (OWA), DO NOT PROCEED. e ———

Configure your installed Outlook client for your new Flank Speed account.

Click on your computer's Windows
icon and go to "Control Panel".
Select "Mail (32-bit)".

& File Explorer Options

8 Intel ® Graphics Settings

~ Keyboard D Mail (32-bit)
B NVIDIA Control Panel & Phone and Modem
&8 Recovery B Region

g ® RemoteApp and Desktop Connections
W~ Security and Maintenance » Sound

& Speech Recognition ¥ Storage Spaces

@ syncC B System [, Taskbar and Navigation W Troubleshooting
8 User Accounts o Windows Defender Firewall

& Work Folders

¥ Windows Mobility Center & Windows To Go

Select "Show Profiles...". @ Mail Setup - FLANKSPEED X

E-mail Accounts

3 Setup e-mail accounts and directories. T e
e
Data Files

tp,. Change settings for the files Outlook uses to Data Files...

=} store e-mail messages and documents.
Profiles

; g Setup multiple profiles of e-mail accounts and

Show Profiles...
data files. Typically, you only need one. -

Close



https://portal.apps.mil 
https://portal.secnav.navy.mil/orgs/OPNAV/N2N6/DDCION/FlankSpeed/SitePages/Home.aspx
https://portal.secnav.navy.mil/orgs/OPNAV/N2N6/DDCION/FlankSpeed/SitePages/Home.aspx
https://outlook-dod.office365.us/

@ Ma X
Select "Add..." to create a new profile. General

Type in "FLANKSPEED" for the profile
name and select "OK".

L\‘_@ The following profiles are set up on this computer:

[ New Profile X
,) Create New Profile oK
Profile Name: Cancel
FLANKSPEED|

[T Remove || Properties | copy...

When starting Microsoft Outlook, use this profile:
O Prompt for a profile to be used

(®) Always use this profile

Your old email address will populate | @« ¥
in the email address box. Ok s ks i e s R,

Delete it and type in your new

<username>@us.navy.mil email Bhesrem

address. Click "Next".

Your Name:

Example: Ellen Adams

E-mail Address: buzz.a.lightyear.mil@us.navy.mil

Example: ellen@contoso.com

Password:
Retype Password:

Type the password your Internet service provider has given you.

() Manual setup or additional server types

Back Next > Cancel

You should see a screen going through B A e _
a series of checks, this will take a few i

minutes. After all three steps have green
check marks, select "Finish".

Configuring

Outlock is completing the setup for your account. This might take several minutes.
~/  Establishing network connection
+  Searching for andrew.m.tash.cv@us.navy.mil settings
+  Logging onto the mail server

Congratulations! Your email account was successfully configured and is ready to use.

[Jchange account settings Add another account...
The "Mail" window should still be open. @ mail X
Ensure your Flank Speed account is se- e

lected under "Always use this profile" B v : t :
. . ¢ following profiles are set up on this computer:
and click "Apply" first and then "OK". - 3

Remove Properties Copy...

When starting Microsoft Outlook, use this profile: !
(C) Prompt for a profile to be used

(®) Always use this profile

Flank Speed bt

oK Cancel Apply




Open your Outlook client. Your email should now start synchronizing (meaning, you will start
to see old emails and invites show up in your Flank Speed inbox). Depending on the size of your
inbox, this could take an hour or more.

Calendar invites will likely be the first thing to appear. If nothing appears, try going to "Send/Receive" and
click "Update Folder".

During synchronization, utilize Outlook Web Access via a browser window (see Step 1) to access
and use your email.

Once you are up and running in Flank Speed Outlook, please reopen Control Panel and repeat
Step 2 on page 1 but instead of selecting "Add..." to create a new profile, select "Remove" and
remove your old @navy.mil account.

PLEASE NOTE: If you used PSTs with your @navy.mil account you will need to remap them
to your Flank Speed Outlook profile. Guidance can be found here on the Microsoft website:
"Open and close Outlook Data Files (.pst)."

Users with shared calendars will need to remove those delegations in support of the mail
migration. Re-establishing shared calendars must wait until users are both mail migrated.

e

TROUBLESHOOTING: If you see one of these two error

Something went wrong.
messages, please follow these steps to remedy:

1. Verify that you have been migrated (Step 1 on page 1). e

If you have, continue below.
2. Attempt to sign into Flank Speed Outlook Web Ac-

cess (OWA) using a private browser in Edge (click the
three dots in the top right of Edge and select "New
InPrivate Window"). If you can connect in private mode, el

your non-private browser is caching old sign-in informa-

tion and the following steps will clear it.

Configuring

An encrypted connection to your mail server is not available.
Click Next to attempt using an unencrypted connection

3. Remove any non-Flank Speed Outlook profiles
(follow Step 2 on page 1, but select "Remove"
instead of "Add...").

« Back Next > Cancel

4, Once your old profile(s) are removed, repeat Step 2 on
page 1 to add your Flank Speed profile.

5. If this does not resolve the issue, call your Service Desk to confirm you have MAPI enabled.



https://support.microsoft.com/en-us/office/open-and-close-outlook-data-files-pst-381b776d-7511-45a0-953a-0935c79d24f2
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Configuring Outlook

First, in your Outlook client, click "File" on the top menu.

Inbox - thamas, burew.cv@us.nawvy.mil - Outiook

Setup Email Security
Account Information

Select "Options".

3 thom
&

4 Add Account

o Account Settings

[ Change seftings for this account or set up more
Account | connections
Scinga Access this account on the w

ittps:/fwebmailapps.mil/owalus.navy.mil

Change

Automatic Replies (Out of Office)
Use automatic replies to notify others that you are owt af office, an vacatian, or
Automatic | ot svsilable to respond to ¢-mail messages

Outlook Optiens ? X

Select “Trust Center”, then -
“Trust Center Settings”.

@ Help keep your documents safe and your computer secure and healthy.

Calendar Security & more
Pecple Visit Office.com to leam more about protecting your privacy and security.
Tasks Microsoft Trustwerthy Computin
Search
Microsoft Outlook Trust Center
Language
. The Trust Center contains security and privacy settings, These settings help keep your
Advanced computer secure. We recommend that you do not change these seftings. Trust Center Settings...

Customize Ribbon
Quick Access Toolbar
Add-ins

Trust Center

Trust Center

Select “Email Security”.

Check "Add digital signature
to outgoing messages" and
then click "Settings".

Trusted Publishers ;
Encrypted e-mail

Privacy Options
9‘3 Encrypt contents and attachments for outgoing messages
i

Email 5
mail Security /| tdd digital signature to outgoing messages

Attachment Handling
Automatic Download Request 5/MIME receipt for all 5/MIME signed messages

Macro Settings Settings...

Programmatic Access Digital IDs (Certificates)

-ﬂ Digital IDs or Certificates are documents that allow you to prave your identity in ele
Publishto GAL... | | Import/Export.. | | Get a Digital ID...

Type in a Security Settings Change Security Settings X
name (Can be anything, eX. Security Setting Preferences

n 8 o n Security Settings Mame:

ActiveClientCerts"). e -

Place a check markin BOTH
default security settings.

Cryptography Format: | S/MIME

v Default Security Setting for this cryptographic message format

| Default Security Setting for all cryptographic messages
Security Labels... MNew Delete

Certificates and Algorithms

Signing Certificate: Signature - BUROW.THOMAS.JAM Choose..

Hash Algorithm: SHA1 ~

Encryption Certificate: |Encryption - BUROW.THOMAS.JAL

Encryption Algorithm: | AES (256-bit) ~
Send these certificates with signed messages

OK Cancel

el L PP Y




Change Security Settings Y Windows Security x

Select a Certificate

Security Setting Preferences

Security Settings Name: Signature -
| AdiveCiient Certs v e
Cryptography Format:  S/MIME Valid From: 12/30/2019 to 11/23/2022
[ Default Security Setting for this cryptographic message format Cl|Ck the fl rst "Choose".". Click here to view certificate properties
Drefault Security Setting for all cryptographic messages i

Securty Labels, | | Mew Delete Select the “Signature” (email) e
Certificates and Algorithms certlflcate Cl|ck "Ok"- Issuer: DOD ID CA-50

Valid From: 12/30/2019 to 11/23/2022

Signing Certificate: Signature - BUROW. THOMAS.JAM Choose...

Hash Algorithm: SHA1 v

Encryption Certificate: |Encryption - BUROW.THOMASJA| || Choose.., |

Encryption Algorithm: | AES (256-bit) w Cllck the
Send these certificates with signed messages second oK Cancel
o Canee "Choose...". — .
You should only have one e o
choice, select the “Encryption” neyEten
certificate. Click "Ok". lsuer: DOD EMAIL CA-50

Valid From: 12/30/2019 to 11/23/2022

In the "Change Security
Settings" box, click "Ok".

oK Cancel

Re-publish your certificates to the GAL

Trusted Publishers

Encrypted e-mail
Privacy Options

Remaining in the "Email Security" tab, | S e e

/| Add digital signature to outgoing messages

click "Publish to GAL..."
oo o Automatic Downigad Request S/MIME receipt for all S/MIME signed messages

Default Setting: | ActiveClient Certs = | | Settings...

Programmatic Access Digital IDs (Certificates)

Click "Ok" on the pop-up.

;I DigitaliDe o Canificates are documents that allow you to prove your identity in electronic transactiens.
Bublish to GAL... I| Import/Export Get a Digital D.
Read as Plain Text

Read all standard mail in plain texct

| Microseft Outloak is about to publish your default security certificates to the Global Address List.

Enter your PIN when requested —
then C“Ck "Ok". ActivClient®
Once done, you will see a status Microsoft Outlook X

message. Click "Ok".

o Your certificates were published successfully,

0K

ke

$5as
o 0
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Global Address List (GAL)

To avoid email delivery errors during Flank Speed transition, send all emails to legacy email
addresses (e.g. @navy.mil). To do that, follow the following steps to get up and running with
the US Navy Global Address List (GAL):

Clear your cache via one of the following two methods.

Method 1 Method 2
Open your Outlook client. Start Outlook using the /CleanAutoCompleteCache switch:
On the "File" tab, select "Options". Select "Start", and then select "Run".
Select the "Mail" tab. Type "Outlook.exe /CleanAutoCompleteCache".

Under "Send Messages", uncheck "Auto-
matic name checking". Then select
"Empty Auto-Complete List". Then "Yes".

| Outiook Options =

7] Savg forwarded messages

V] Ssye copies of messages in the Sent tems folder

Mail

V] Use Unicode format

4 DefaultImportance levet: > Normal[v ]
Default Sensitivity levet:  [Normal  [+]

Mark messages as expired after this many days:

\en COmposing new messages

ultiple meszage recipients

ations from Inbox after responding

9] CTRL + ENTER se

7] Use Auto-Compl
and Bec lines

7] Warm me when I send a message that may be missing an attachment

whi ing in the T
g9estrames whentypinginthe To, &, (1 e Dbyl oot g

Force a GAL sync so that "US Navy" shows up in the Address Book List.

Navigate to the following file using "File Explorer"
c:\Program Files (x86)\Microsoft Office\GlobalDirectory\GALSYNCU.exe

When at the file location, double click the program and let it run.

Close and restart Outlook.




Set your default GAL to ""US Navy".

Open your Outlook client and from the "Home" tab click on "Address Book".

“ [EGIIENN Send f Receive  Folder  View  McAfee E-mail Scan J Tell me what you want to do.

il W Move to: 7 nage ;
W [ @xlgnore x F Mecting | Move t nager ¥ ] ,&E: ﬁl >
- L Clean Up - oS = Tean ; 3 [} Address Book
New New o Delete Reply Reply Forward [ piore ~ = - T . Move Rule: OneNote Aszign Unread/ Categorize Follow -
Email ltems~ %5 Junk Al o # heply & Delete Create New ¥ i : Policy - IR : Fie W Filter Email
MNiw Delete Respond T F

Quick Stef 3 Move Tags Find

From the pop-up menu, click on "Tools" then "Options".

From the second pop-up menu, click the radio button for "Custom" and select "US Navy". Click the up
arrow to the right of the list until it hits the top of the Custom lists. On the last drop-down menu select
"US Navy" to instruct Outlook to use the US Navy GAL by default. Click "OK".

Addressing x

When sending e-mail, check address lists in this order:

() start with Global Address List
() Start with contact folders

@) Custom
~
Offline Global Address List 1
Contacts
BUMED
EDS 3
Office of the Secretary of Defense v

Add... Remove Properties

When opening the address book, show this address list first:
v

QK Cancel

Reboot Outlook for the changes to take place.

P 3 8
AL e g R 7%
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Encrypted Emails

How to send S/MIME encrypted emails using Flank Speed email (@us.navy.mil) in Outlook 2016.
Open Outlook. Select "New Email". Click "To".

Under the Address Book header, click on the drop down menu and select "US Navy"
(reference previous page, Step 3). Search for the users you need to send an email to and
add them. Close the address book.

Under the "Options" tab select "Encrypt" and/or "Sign" as appropriate.
Test of Encrypted Email - Message (HTML)

Message  Insert SIS I Format Text Review () Tell me what you want to do...

P L B === 0 " ) o
A] Ecolors- ASH E= 25 Encrypt | (U] Request a Delivery Receipt | LYl 1=
e p ¢ : VX q ry Receipf — [V
[AlFonts- o | amme 3 Q v <
Themes T Page  Bcc From  Permission @igian!  [lUse Voting [ | Request a Read Receipt  Save Sent Delay  Direct
- ects ~ Color - - Buttons ~ Item To ~ Delivery Replies To
Themes Show Fields Permission Tracking & More Options ]
To.. I ric r [1)
17
Ce
Send
Subject |Test of Encrypted Email
This is a test of encrypted and digitally signed email.|
n n; it
iz ?
Select o K |f p ro m pted . | ActivClient - PIN Always Prompt ? X
" n ActiviD*
Hit "Send". ActivClient*

You are about to digitally sign a file or message.
Please confirm that you want to use your smart card for this operation.

OK Cancel
TROUBLESHOOTING: You may see this error invalid Certificate X
when trying to sign or encrypt an email for the ™ L i
fi rst time from the client after m|grat|on_ | account, or use the Accounts bulton to send the message using an account that you have certificates for.
Follow these steps to resolve:
1. Goto File > Options > Trust Center > Trust s

Center Settings > Email Security.

2. Navigate to Encrypted email > Default Setting > Settings.
Type in a name for security settings (e.g. “My Policy”).

3. Under "Certificates and Algorithms", click "Choose" to the right of Signing Certificate.
Ensure the Signature certificate is selected. Click "OK".

Do the same for "Encryption Certificate". Click "OK".
5. Check "Send these certificates with signed messages". Click "OK".




